
2MScheduler User Manual
This document will help you understand and use the 
2MScheduler controller software for the eMedia  
and eVidia display systems.

Introduction
2MScheduler controller software functions in two capacities: As a 
standalone scheduler for directly managing text, ticker, graphics, 
animation and video show schedules for eMedia and eVidia display 
controllers, and as a show scheduler for eClips.* 

When used alone, it provides the ability to schedule shows days, 
weeks or months in advance using a variety of media types as well 
as XML or text-based ticker (traveling or scrolling text) messages. It 
allows assignment of media clips or shows to advertisers, providing 
detailed reporting for delivery accountability.

2MScheduler is available as an upgrade to FlyerPro 3.

*If used with eClips, refer instead to the eClips User Manual, which 
includes coverage of the functions of 2MScheduler.

Multimedia
3300 Monier Circle
Rancho Cordova, CA 95742
Tel: (916) 852-4220
Fax: (916) 852-8325
Email: info@multimedialed.com
http://www.multimediaLED.com2MScheduler User Manual 7/1/04rw



Page 2 © Copyright 2004, Multimedia LED. All rights reserved

2MScheduler User Manual
Table of Contents

Contents

Introduction

Getting Started
Launching, Viewing “Sign” Window. . . . . . 4
Player Mode vs. Scheduler Mode . . . . . . . 4
Adding Files (Clips) . . . . . . . . . . . . . . . . . . 5

Advertisers
Advertisers  . . . . . . . . . . . . . . . . . . . . . . . . 6
Adding an Event  . . . . . . . . . . . . . . . . . . . . 7

Creating Schedules
Adding Events using Drag and Drop. . . . . 8
Using the Duration(s) Field:  . . . . . . . . . . . 8
Using the Priority Field  . . . . . . . . . . . . . . . 9
Changing the Event Type  . . . . . . . . . . . . . 9
Adding Events using Add Event Button. . . 9

Creating Schedules
Creating a Schedule Using a Template. . 10
Saving a Schedule  . . . . . . . . . . . . . . . . . 10



© Copyright 2004, Multimedia LED. All rights reserved Page 3 

2MScheduler User Manual
Getting Started

2MScheduler Controller Software 2MScheduler Overview
2MScheduler is designed to work with Multimedia’s 
LED video controllers: the eVidia and eMedia. It 
provides a convenient user interface for organizing 
sound, video, animation and graphic images into 
scheduled shows, and provides detailed accounting of 
play time and duration for advertiser accountability.

User Activities:

Import media clips: Select graphics, video and 
animation clips from local or networked storage 
devices and import them. This process mirrors the 
files to the controller and to the authoring station.

Assign Advertiser: By assigning unique advertiser 
names to each clip that is imported, play time can be 
recorded and detailed reports can be generated.

View Reports: This area provides reporting of 
ad exposure. These reports can be read within 
2MScheduler or exported in various formats.

Create Text: Enter text for immediate or future use in 
the show.

Choose Templates: Templates predefine areas of 
the display for different types of content. A live 
video source can be displayed picture-in-picture 
with a graphic, animation or another video, with text 
overlayed and scrolling or paging across any area of 
the display. Seperate Template Editor software allows 
you to design custom templates.

Video Sources: 2MScheduler supports multiple 
displays. The Video Sources window identifies and 
specifies each display available for use.

Position: The positioning of the clips on the display 
can be adjusted to pixel perfect position, or simply 
centered, aligned to the upper left, or stretched to fit.
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Launching, Viewing “Sign” Window

When 2MScheduler is launched, the “Select Sign” 
window opens first. This allows those with multiple 
signs and controllers to choose which sign will be 
used from the list on the left side of this screen. 
Most users will have one sign, and will not need to 
make this choice.

• The sign’s vital statistics appear on the right side 
of the screen. This is both useful for recognizing 
which screen is selected, but also allows those 
specifications to be changed. Do not make 
changes without contacting Multimedia Support.

• Once the sign is selected, click the “OK” button.

• If you need to return to this screen to make 
changes later, you can click the “Signs” button.

Windows “Start” menu

“Sign” window

Player Mode vs. Scheduler Mode

When using 2MScheduler with eClips, 2MScheduler 
must be in “Scheduler” mode. When used as a 
standalone program, it must be in “Player” mode.

• When in “Player” mode, there will be a black 
window without a frame in the upper-right 
corner of the screen. This “Player Window” 
displays the clips when the “Play” button in the 
menu bar is clicked.

• To switch between modes, select “Run as 
Player” from the “Options” menu and then quit 
and restart 2MScheduler. Note that a check 
mark will appear next to “Run as Player” if it has 
been selected.
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Adding Files (Clips)

Events are clips or text that has been scheduled to 
play in a particular sequency or at a particular time. 
To add graphics, animations or video files, you must 
first import them into 2MScheduler.

There are two ways to add files:

1. Select “Files” from the “File” menu.

•  You will be presented with a “Files” window 
which lists already imported files. Click the 
“Add Files” button. 

• You will be presented with a standard 
Windows “Open” window, where you can 
browse to where you’ve stored the video 
files. Select the files you want and click 
“Open”. You will see the files being imported 
and will be returned to the “Files” window.

2. Click the  “Add Files” button.

• You will be presented with a standard 
Windows “Open” window, where you can 
browse to where you’ve stored the video 
files. Select the files you want and click 
“Open”. You will return to the same menu and 
the files will appear in the “Files List”.

2MScheduler User Manual
Adding Files
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Advertisers

There are two steps to managing Advertisers: 
Entering Advertiser IDs and assigning Advertisers  to 
clips (this is one step), and reporting.

1. To enter a new advertiser:

• Select “Files” from the “File” menu.
• Select a file from the “File List”
• Click the “Change Advertiser” button.
• In the “Change Advertiser” window, enter 

the name of the Advertiser (or client #, 
or whatever system you choose to track 
clients). Be sure you spell names consistently 
or they will appear in the reports as separate 
advertisers.

• Click “OK”
• The Advertiser’s name will appear in the first 

column of the File List.

2. Viewing Reports:

• Select “Reports” from the “View” menu

• Click the “Run Report” button

• After a fiew seconds an “Event History 
Report” will appear in the “Reports” window. 
This is the report for the first Advertiser in 
the list.

• Click other Advertisers in the Advertiser List 
to view their Event History Reports.

• Click the small box with the “+” to the 
left of the Advertiser name to expand the 
listing to see individual clips assigned to that 
Advertiser. After clicking, the “+” becomes a 
“-” to indicate that the menu has expanded. 
Clicking on “-” will collapse the menu.

• Click the small box with the “+” to the left of 
the clip name to view individual dates.

• Click on the individual date to view the report 
for that date.

• A tab will appear to make it easy to navigate 
between reports.

2MScheduler User Manual
Advertisers
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Adding an Event

There are two ways to add an event:

1.  Drag and drop a file from the “Files” palette. 
When the file is dropped into the Schedule 
Window, a Schedule Information window 
automatically opens to set the start and end 
time and date, duration, priority and excluded 
days. (More on next page.)

 This approach allows you to quickly move 
Media Clips to the schedule. If you want to 
make changes you can double-click anywhere 
in the Event’s row in the schedule window. 
However, it doesn’t allow you to add Text or 
Live Video events.

2. Click the Add Event button and you will 
immediately see a new window which displays 
the available files, allows you to sort by file 
type, rename an event, set the date and time, 
and add text. (More on page 29.)

 This approach allows you to select Media Clips 
like the first approach. But it also allows you to 
create Text and Live Video Events.

In addition to adding events to a simple sequential 
schedule, 2MScheduler can work with Templates 
designed in Template Editor, creating  schedules for 
each block (zone) of the Template.

2MScheduler User Manual
Creating Schedules
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Adding Events using Drag and 
Drop

1. Select a Media Clip from the Files Palette and 
drag it into the Schedule Window.

2. A Schedule Information Window opens 
automatically.

3. By default, the checkboxes marked “Always” 
is checked. Until they are unchecked, the 
schedule cannot be changed. 

• To simply play the clips, one after another 
without regard to time or day, leave “Always” 
checked.

• To play the clip on a specific day, whenever 
it comes up in the queue, uncheck the 
“Always” check box next to the calendar, and 
choose the start (left calendar) and end (right 
calendar) days. For one day only, select the 
same date on both calendars. 

• To have the clip play at a particular time of 
day, every day, uncheck ONLY the Always 
check box next to the Start Time/End Time 
fields.

• To have the clip play on a specific day at a 
specific time, uncheck BOTH the “Always” 
check boxes next to the calendars, and the 
Start Time/End Time fields.

• To play the clip at all times except a certain 
day of the week, uncheck the “Always” check 
box next to the Excluded Days buttons, while 
leaving BOTH the calendar and Start Time/
End Time fields checked.

Using the Duration(s) Field:

The Duration(s) Field shows the duration of an event 
in seconds. 

• Stored video and animation clips have a built-in 
duration, which cannot be changed.

• Live Video Events allow you to set the duration.
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Using the Priority Field

Setting the priority for a scheduled clip will change 
how it behaves when another clip overlaps its 
schedule. The schedules may overlap when an 
unscheduled event encounters a scheduled event, 
or a scheduled event is scheduled to begin before 
another clip is completed.

If a clip encountering another clip has a higher 
priority, it will interrupt the other clip.

Changing the Event Type

When a media clip is dropped into the calendar, 
the initial assumption will be that the clip imposes 
the media type. However, it can be changed. 
Within the initial Schedule Information Window 
that automatically opens, the option to change the 
media type is not there. However, once that window 
is gone, you can double-click on the event in the 
schedule, and in THIS Schedule Information window, 
change the event to a Live Video (Direct Video Feed), 
XML Text Message or Manual Text Message event 
by selecting the “Event Type” tab at the top of the 
window, and clicking next to the new media type. If 
you change to a Text media type, you can now click 
on the Text tab and add whatever text you wish to 
display.

Adding Events using Add Event 
Button.

Using the “Add Event” button does all the same 
things as dragging and dropping from the Files 
palette, but in a different order.

1. Click the “Add Event” button

2. This Schedule Information window, very similar 
to those mentioned above, allows you to:

• Name the Event
• Change the Event Type
• Select an existing media clip
• By clicking the “Date/Time” tab you can set 

days, dates, priorities, etc. (see previous 
page for details on how these interact.

• By clicking the “Text” tab you can set text 
messages. (See previous page for details.)
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Creating a Schedule Using a 
Template

1. In the Files menu, select “New –>Template 
Schedule” or pull down the menu next to the 
“New” button and select “Template Schedule”.

2. In the next window you will be asked to select 
a Template by name. These templates were 
previously designed in Template Editor.

 Select a Template.

3. The Template appears in a lower pane of the 
the Schedule window. Clicking on a Template 
zone will allow you to create a schedule for that 
zone, using the media types allowed for that 
zone.

4. Follow the instructions under “Adding an Event  
Using Drag and Drop” on Page 28.

Saving a Schedule

There are two ways to save the schedule:

1. Click the “Save” button. 

2. Choose “Save” or “Save As” from the File 
menu. 

• You will be given the opportunity to name the 
schedule, and you will be able to see existing 
schedules.

• Type a name for the schedule and click 
“Save”. 

 It is useful to understand that you are not given 
the opportunity to choose where the schedule 
is saved. It always is saved in the same 
location, and is mirrored on the Controller, 
automatically.

When you next open eClips, the new schedule will 
appear in the Schedules window, ready for use.


